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High Quality Fotos in SL

1. Einfihrung

Torley Linden hat unter https://wiki.secondlife.com/wiki/User:Torley Linden/Snapshot_tips Anleitungen
fiir bessere Bilder geschrieben.

Wir teilen die Freude von Torley Linden an den fotografischen Moglichkeiten von Secondlife. So wie
Torley haben auch wir jede Menge von Bildern in SL gemacht und es auch zu einer kleinen Ausstellung
in der realen Welt gebracht.

Wer SL Guided Tours kennt hat auch schon einige Bilder von uns gesehen — auf unsere Web-Seite.

Um die deutschsprachige Community zu unterstiitzen haben wir unsere Versuche, Torleys Tipps
nachzuvollziehen, hier dokumentiert.

Wir haben daher Torley’s Tips nachvollzogen und mit unseren eigenen Erfahrungen verglichen und das
Ganze auch gleich niedergeschrieben.

Die Bilder von Menii’s wurde auf einem englischen SL Client gemacht, die deutschen Meniieintrige
fident ihr sicher selbst raus.

2. Wichtige Hinweise

Bevor ihr was verindert, schreibt euch die Einstellungen auf — manche Anderungen machen den SL
Client zu langsam und es ist dann keine Freude mehr, damit zu arbeiten.

Wir haben uns angewohnt, die hochauflosenden Supereinstellungen ausschlielich zum fotografieren zu
machen und fiir den ,,Normalbetrieb* auf eher leistungsoptimierte Einstellungen zuriickzugreifen.

3. Mac Anwender
Wer mit einem Mac arbeitet: Alt = Opt und Ctrl = Cmd

Viel Spal} beim fotografieren wiinschen Euch

Wolwaner Jervil Valie Eun

SL Guided Tours

Wir fiihren euch gerne durch SL und wir verdffentlichen auch unsere Landmarks auf
Web-Seiten und Inworld.

Unsere Web-Seite, die Euch mehr an Informationen zeigt:
http://members.al.net/secondlife

oder als Seite fiir das Inworld-Profil
http://members.al.net/secondlife/profil/
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4. Markierungen im Text

So werden Ausdriicke fir den deutschen SL Client markiert.
Und so die englischen.

5. Grundlegende Einstellungen

Bearbeiten  Ansicht  Welt

Bild hochladen (10 L§)...
sound hochladen (10 L$)...
Animation hochladen (10 L$)...
Mehrfach-Upload (10 L$ pro Datei)...

Ctrl-U

Fenster schliefen Ctrl-W

Alle Fenster schliefen  Ctrl-Shift-W
Teatur speichem unter..,

Foto machen Ctrl-shift-s
Foto auf Datentrdger Chrl-"
Beenden ctrl-qQ

Wie man ein Bild auf die Harddisk speichert

.. oder wie man seine Erinnerungen konserviert.

Variante 1

MenU Menu: Datei-> Foto machen File>Take Snapshot
Tastatur Shortcut: Strg-Umsch-S Ctrl-Shift-S

Knopf Button: Foto Snapshot

Damit wird ein Fenster geoffnet, in dem man einige Auswahl treffen
kann. Wir verwenden:
e Auf Festplatte speichern Save snapshot to hard drive
Die anderen Optionen empfehle ich nicht. Es ist besser, mal

ein Bild zu machen, dann in einem Grafikprogramm zu bearbeiten und danach hinaufladen oder

Iweck des Fotos
3 Per E-Mail senden
) Im Inventar speichern (L§10)
= auf Festplatte speichern

| Dateigrifie; 800 KB

|

|| speichem

[ Foto aktualisieren ]
- |[ Abbrechen ]

|

| Grife
| | Aktuelles Fenster ~ || JPEG

Bildgualitat :O 100

| Aufneiime| Farben

Format

i |

Bretel] 200 | Wohe [7>+ |

[ | seitenverhiltnis beibehalten

|

[l Interface auf Foto anzeigen

[ HuD-Dbjekte auf Foto anzeigen

[ Nach dem Speichern offen lassen
] Frame einfrieren (Vollbildvorschau)
] Automatisch aktualisieren

verwendet)
ACHTUNG: Diese Art des Fotos beriicksichtigt die Einstellung Advanced->Hi-res Snapshot
Advanced >Hi-res Snapshot
Wenn das eingeschaltet ist, wird ein Foto mit der doppelten Auflosung (=4-fache GréBe) gemacht!

versenden. Allerdings gibt es einen ,,Referral Bonus®, wenn
man jemanden eine Postkarte sendet und sich dann ]emand
mit der Empfinger-E-Mail anmeldet (habe ich noch nicht
versucht).
e GroBe Size: Aktuelles Fenster Current Window
Damit bekommt man die aktuelle Fenstergrofe. Es ist
durchaus sinnvoll, hier auch mal zu variieren, aber
ACHTUNG - das hat Auswirkung auf die Bildgroe — und es
dauert lange, wenn das Bild zu grof3 wird.
e Format JPEG, BMP, PNG - wir verwenden zumeist BMP,
bei Verwendung von JPEG verwenden wir ausschlieflich 100
bei der Bildqualitit! Bei BMP und PNG gibt es den Regler
nicht.
Aufnehmen Capture: Farben Colors
¢ Alle anderen Checkboxen: aus, nicht angehakt, in gewissen
Situationen ist einiges durchaus zu verwenden.
Automatisch aktualisieren Auto-snapshot: Torley
verwendet das nicht, wir verwenden das sehr wohl, da wir
damit sofort nach Aufruf einmal ein Bild erhalten — das
kommt auf die Situation an.

Variante 2

Mend Menu: Datei->Foto auf Datentrager File>Snapshot to
disk

Tastatur Shortcut: Strg-6 Ctrl-

Damit wird ein Foto auf die Festplatte gespeichert, ohne das

~ Auswabhlfenster zu 6ffnen (die gemachten Vorgaben werden allerdings

© Wolwaner Jervil
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Advanced Menu einschalten
Mit Strg-Alt-D (PC) oder Opt-Ctrl-D (Mac) 6ffnet man das Advanced Menu.

Im Advanced Menu gibt es den Eintrag High-res Snapshot. Wenn ihr den ankreuzt, werden die Bilder in
doppelter Breite und doppelter Hohe gemacht, d.h. wenn das Fenster 600x400 Pixel ist, wird ein Bild von
1200x800 Pixel gemacht.

¥ Second Life

Datei  Bearbeiten  Ansicht Welt Werkzeug Hilfe ~Advanced (7,93, Help Peoplelsland 59, 46, 23 (PG

Consoles :-E
Y Reload personal setting overrides  Ctrl-Shift-F2
i“' ’, ' HUD Info »
0&) X High-res Snapshot

X Quiet Snapshots to Disk

Compress Snapshots to Disk
¥ Show Mouselook Crosshairs

*oMis bpuoeg | Debug Permissions I

Clear Group Cache
P-4 k

ACHTUNG: Diese Option wirkt so nur, wenn ihr

Menl Menu: Datei->Foto auf Datentrager File >Snapshot to disk
Tastatur Shortcut: Strg-6 Ctrl-

verwendet!

Wer mit

MenU Menu: Datei->Foto machen File 2> Take Snapshot

Tastatur Shortcut: Strg-Umsch-S Cirl-Shift-S

Knopf Button: Foto Snapshot

Fenster Foto-Vorschau Snapshot-Preview offnet, muss die entsprechenden Einstellungen dort
vornehmen. Dafiir konnt ihr euch auch noch groBere Auflésungen (Maximal 6016px) aussuchen, aber
Achtung — die Bilder werden entsprechend grof3 — ein 6016px breites und ca. 4000px hohes Bild
verbraucht 77MB - und die Zeit zum Speichern verldngert sich demnach.

Achtung! Je hoher die Auflésung, umso linger wird euer SL eingefroren, es kann auch zu Abstiirzen
kommen.

Beim ersten Foto nach dem einloggen wird ein Fenster gedffnet, in dem man den Dateinamen fiir das Bild
angeben kann. Jedes weitere Bild wird im gleichen Ordner und unter dem gleichen Namen mit
fortlaufender Nummerierung gespeichert. Den Namen kann man erst nach einem erneuten login wieder
dndern. Das ist eine schnelle Moglichkeit fiir eine Bilderserie.

Die auf diese Weise gespeicherten Bilder konnen mit jedem iiblichen Grafikprogramm entsprechend
bearbeitet werden.

Kontrolle der Kamera
1. Tastatur:
Grundsitzlich geht alles schnell und einfach, wenn man die Tastaturkiirzel verwendet, um die Kamera zu
steuern — und wer das nicht weil3, sollte eigentlich gar nicht fotografieren:
e Taste Alt und ein Mausklick irgendwohin bringt den mit der Maus anvisierten Punkt in die
Bildschirmmitte.
e Taste Alt, Mausklick und die Maus bewegen bewirkt ein Zoom und eine Rotation der Kamera um
den fokussierten Mittelpunkt.
e Taste Alt und Strg, Mausklick ,rotiert” die Kamera um den Mittelpunkt (nach oben, unten, zur
Seite — der Mittelpunkt bleibt jedoch in der Mitte.
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e Taste Alt, Strg und Umschalten (hochstellen oder so) bewirkt eine Verschiebung der Kamera in
der Ebene — d.h. ein flaches verschieben, es wird ein anderer Mittelpunkt festgelegt.
Und wenn es zu umstédndlich erklért ist — einfach ausprobieren!

2. Ansicht->Kamerasteuerung View>Camera Controls:
Damit bekommt Ihr diese Hilfe zur Kamerasteuerung und braucht keine
Fingerfertigkeiten.

Vollbildmodus oder Window:

Wir verwenden SL immer im Vollbildmodus — das verhindert zwar den einfachen Zugriff auf andere
Applikationen, dafiir machen wir “riesige” Bilder. Wenn ihr das nicht macht, vergroB3ert SL so weit wie
moglich.

Grafikeinstellungen (Strg-P Cirl-P, Reiter Grafik)

Generell gilt: Je besser, desto langsamer wird alles — wir stellen je nach Bedarf ein, d.h. zum Bilder
machen alles auf hoch, alle Schieberegler nach rechts, fiir normales benutzen eher auf mittel.

e Bei den Knopfen gilt, je weiter unten, desto besser, aber auch langsamer.

e Bei den Schiebern gilt, je weiter rechts, desto besser, aber auch langsamer.
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Qualitat und Dieser Regler ermoglicht eine schnelle Umstellung zwischen Geschwindigkeit und
Performance Qualitdt. Auf meiner Maschine wire die empfohlene Einstellung Hoch High — wir
Quality and verwenden normalerweise Mittel Mid, zum Fotografieren allerdings Ultra Ulira. Die
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Performance Auswirkungen sind je nach System unterschiedlich, einfach mal versuchen.

Sichtweite Draw | Die Sichtweite bringt mehr Details auf das Bild. Fiir gute Bilder gehen wir auf das

Distance Maximum bzw. wir versuchen, damit auch eine gewisse Bildkomposition zu
erreichen, normalerweise begniigen wir uns mit 128, oder den Standardvorgaben.

Gitterdetails Je hoher, umso bessere Details sind zu sehen.

Mesh Detail

Lokale Die lokale Beleuchtung bringt nicht nur mehr 3D in die Bilder, das muss auch

Lichtquellen eingeschaltet sein, damit Facelights bzw. Scheinwerfer ihre Wirkung tun —

Nearby Local unbedingt einschalten.

Lights

Anistrophische Ist in den Hardware Optionen Hardware Options verborgen und sollte fiir

Filterung bessere Auflosung von entfernten Objekten eingeschaltet sein.

Anistrophic

filtering

Antialiasing Ist in den Hardware Optionen Hardware Options. Macht alles ein wenig weicher

Antialiasing und natiirlicher.

Andere niitzliche Dinge:

Zoom in und out: Uber Menu Ansicht->Hinein zoomen, Zoom Standard, Wegzoomen
View—=Zoom in, Default, Out kann man einfach in Schritten hin und her zoomen — auch dann, wenn
man mit der Maussteuerung der Kamera nicht mehr herankommt. Wer schnell sein will, verwendet die
Tastatur fiir’s zoomen: Strg-0 Cifr/-O=Hinein zoomen, Strg-8 Cirl-8=Wegzoomen, Weitwinkel), Strg-9
Ctrl-9=Standard (kein Zoom, Kamera wieder in Standardposition).

Disable Camera Constraints: Die Draw distance haben wir bereits bei den Grafikeinstellungen
erwihnt, hier ist noch ein Zusatz, der es erlaubt, die Kamera viel weiter weg zu platzieren, als das
normalerweise der Fall ist. Im Menu Advanced->»Disable Camera Constraints Advanced->Disable
Camera Constraints ankreuzen (Strg-Alt-C Ctrl-Alt-C) und schon gibt es nahezu keine Entfernungs-
oder sonstige Limits, wohin man die Kamera bewegen kann.

Einstellungen fiir die Beleuchtung
Mit der Einfiihrung von Windlight (Ab Version 1.19) wurden eine Menge weiterer Moglichkeiten
geschaffen, die Umgebung fiir bessere Bilder einzustellen.

Einfach geht das mit den altbekannten Einstellungen im Menu Welt-Umwelteinstellungen World >
Environment settings und die gewiinschte Tageszeit auswihlen. Allerdings gibt es da auch den Punkt
Umwelt-Editor Environment Editor.

Damit lassen sich eine Menge Einstellungen dndern, die groen Einfluss auf ein Bild haben.
Sonnenstellungen zu unterschiedlichen Tageszeiten, auch Nacht und Mond ist moglich.

Wir verwenden gerne einmal die vordefinierten Einstellungen — die machen alleine schon eine Menge
Effekte.

Und wenn man mal alles falsch eingestellt hat, gibt es hier eine Moglichkeit zum zuriicksetzen:
Menu Welt-Umwelteinstellungen-> Auf Regionsstandard zurticksetzen World> Environment
settings 2> Revert to Region Default.
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Der Umwelt-Editor
|'_"_~éf Second Life
Datei  Bearbeiten  Ansicht . Werkzeug  Hilfe  Advanced @3% Help People Island 59, 46, 23
Chat J !
Immer rennen Ctrl-R
Fliegen Home

Landmarke hier setzen
Hier als Zuhause wahlen

A Teleport nach Hause Ctrl-Shift-H

Als abwesend anzeigen
Set Busy

Alle Animationen stoppen
Tasten freigeben

Kontostatistik...
Mein Konto verwalten...
L$ kaufen...

Mein Land...
Land-Info...
Land kaufen...

Region/Grundstlick...

g = Sonnenaufgang

g - Mittag Ctrl-shift-y
e —— Sonnenuntergang  Ctrl-Shift-N
= = :-5-: _— Mitternacht

::_E;-" Tj__‘: — - - = i -4 AufRegionsstandard zuriicksetzen

Mit dem Editor wurden Moglichkeiten geschaffen, die eine wesentliche Erweiterung fiir Fotografen
darstellt. Zuerst einmal kann man hier die Tageszeit, Wolkendecke, Wasserfarbe und Wassertriibung
einstellen — das macht schon mal einiges her.

Wolkendecke c—re—— ;7  Wasser =P 4,00

[ Grundstiickszeit wverw, ] ] Himmel (erweitert) [ [ ..:'l;l'ﬂ.s’.iﬂfﬂﬂﬂﬁtﬁ'ﬂ ]

Wesentlich interessanter wird es mit Himmel (erweitert) Advanced sky.
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Atmosphare Atmosphere
Default
Desert Sunset
Fine Day
Fuffy Big Clouds

Foggy

Funky Funly
Funky Funky Funly
Gelatto

Ghost

Incongruent Truths wenn Fe'brauchst “ichhe
ﬁ Midday 1
Midday 2
Midday 3
—— Midday 4
Might
e Pirate
— Purple
Sailor's Delight
Sheer Surreality

Fiir eine rasche Auswahl gib es eine Menge vordefinierter Einstellungen. Versucht mal Fluffy Big
Clouds. Hier konnt ihr auch jede Menge anderer Parameter fiir die Atmosphire einstellen. Fiir
Landschaften bewirkt die Horizonttriibung eine Moglichkeit zur natiirlicheren Gestaltung.

Licht Lightning

[ v e

Hier sind die Lichteinstellungen und auch die Einstellung fiir die Tageszeit — und ganz wichtig, die
Ostausrichtung East Angle. Die Sonnenleuchtkraft Sun Glow ist fiir Sonnenuntergangsfotos
hilfreich. Die Sternenleuchtkraft Star Brightness macht einen wunderschonen Nachthimmel.

Wolken Clouds
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e || Licht | TVRITES

Alle Einstellungen, um ein paar schone Wolken auf den Himmel zu zaubern. Zusitzlich die Moglichkeit,
Wolken auch still stehen zu lassen und zu justieren. Experimenten ist kein Limit gesetzt.

Sonstige Ideen

Obwohl sich mit dem Umwelteditor vieles schon mit Sonne, Mond und Sternen beleuchten lisst, und das
auch Auswirkungen auf nahe Objekte und Avatare hat, ist das fiir Portraits und Modefotos nicht immer
ausreichend.

Hier gibt es allerdings noch die Mdéglichkeiten der leuchtenden Objekte wie Facelights und entsprechend
positionierte Leuchtmittel.

Nachbearbeitung in verschiedensten Programmen ist auch eine Moglichkeit, das hervorzuheben, was man
betonen will.

Grafikformate zum Hochladen
Empfohlen wird: TGA oder PNG, keinesfalls JPG.

Wir erstellen die Bilder in der gewiinschten Auflésung mit Gimp und verwenden normalerweise TGA als
Format.

SL mag grundsitzlich quadratische GroBen. Fiir spezielle Bilder mag eine Bildgroe von 1024x1024
Pixelsein, fiir den Normalfall reicht 512x512 Pixel bei weitem und schneller angezeigt wird 256x256
Pixel in guter Qualitit. Man sollte immer bedenken, dass eine Verdoppelung der Auflosung die 4-fache
Datenmenge bedeutet.

Versuch und Irrtum

Hochladen kostet Geld — L$10 — das ist zwar nicht viel, bei mehreren Versuchen jedoch auch ein
Kostenfaktor.

Billiger ist es im Beta-Test Grid (wenn verfiigbar) oder bei alternativen Anbietern wie OpenSim.
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